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Brand Goal

Section 1.1: Brand Goal

Tasty Indian Bistro is a hospitality brand 

committed to culinary excellence. Rising to 

become the premier indian restaurant brand in 

North America, the organization comes from a 

deep history of tradition and family values.

Our Mission

“Creating an everlasting Tasty experience 

by sharing the bowl of happiness in a family 

environment.”

Our Vision Statement

“The Vision of Tasty Indian Bistro is to become the 

best and most renowned restaurant across the 

nation, while maintaining our uncompromising 

values as we grow.”

Our Values

T: Teamwork & Trust (Teamwork & Trust is our 

family’s foundation)

A: Appreciate (We appreciate, learn & adapt from 

our internal & external guests)

S: Success & Society (Our success lies in the giving 

back to the society)

T: Transcend (Our key members are always looking 

for an opportunity to go above and beyond)

Y: You (It’s all about YOU) 
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Keywords
Our brand is characterised by the following 

keywords. These keywords drive the direction 

and vision of the brand design. The Tasty brand 

encapsulates an East meets West culinary 

experience. 

 

Our food is carefully prepared with love, and has 

been developed to serve the more North American 

palette. As the brand continues to advance across 

North America, we will continue to drive the 

organization towards broad appeal, that feels 

welcoming to all cultures and walks of life.

Classic 
Understated 

Royal
Elegant
Upbeat 
Cultural
Family

Ambience

Word List

Epic
Minimal 

Contemporary 
Industry Leader

Delicious
Indian Infused

North American 
Unique 

1.0 / THE BRAND Section 1.2: Keywords
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Primary Logo
This is the Primary Logo. The logo must be resized 

proportionately, never stretched. The Logo can 

be used in black on light backgrounds, or white on 

dark backgrounds, or in contrasting brand colours.

Download Logos

2.0 / LOGO Section 2.1: Primary Logo

https://drive.google.com/open?id=1XPYOwcHgFvtUVpSavDtJWDa6Vg9WmsF0
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Logo Clear Space

Clear space is the area surrounding our logo that 

must be kept free of any text or graphic elements. 

By leaving space around the logo, we make sure 

it stands out on all our communications. The 

minimum clear space is 50% of the height of the 

entire logo.  

 

It is sometimes necessary to increase and decrease 

the logo depending on the print area. Always keep 

in proportion. Always ensure the text is legible. 

Download Logos

2.0 / LOGO Section 2.2: Logo Clear Space 

100% of Logo Height 100% of Logo Height

100% of Logo Height

100% of Logo Height

https://drive.google.com/open?id=1XPYOwcHgFvtUVpSavDtJWDa6Vg9WmsF0
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Secondary Logo
This is the Secondary Logo. The logo must be 

resized proportionately, never stretched. The Logo 

can be used in black on light backgrounds, or white 

on dark backgrounds, or in contrasting brand 

colours.

Download Logos

2.0 / LOGO Section 2.3: Secondary Logo

https://drive.google.com/open?id=1D4icQP0l4GWjpUXJcDDBQLss8WHMxpoJ


TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 11

Logo Clear Space
Clear space is the area surrounding our logo that 

must be kept free of any text or graphic elements. 

By leaving space around the logo, we make sure 

it stands out on all our communications. The 

minimum clear space is 100% of the height of the 

entire logo.  

 

It is sometimes necessary to increase and decrease 

the logo depending on the print area. Always keep 

in proportion. Always ensure the text is legible. 

Download Logos

2.0 / LOGO Section 2.4: Logo Clear Space 

100% of Logo Height

100% of Logo Height

100% of Logo 
Height

100% of Logo 
Height

https://drive.google.com/open?id=1D4icQP0l4GWjpUXJcDDBQLss8WHMxpoJ


TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 12

This is the Tertiary Logo / Brand Stamp. The 

Brand Stamp must be resized proportionately, 

never stretched. The Brand Stamp can be used 

in black on light backgrounds, or white on dark 

backgrounds, or in contrasting brand colours. 

This usage is primarily for legibility / readability on 

advertising materials, and when space is limited.

Tertiary Logo

Download Logos

2.0 / LOGO Section 2.5: Brand Stamp

https://drive.google.com/open?id=1Qg_eUOqZmY6bdnUBND0Of_DfoMskqfFv


100% of Primary Logo Height

100% of ‘INDIAN BISTRO WORDMARK’ Height

100% of Primary Logo Height

100% of 
Primary Logo 

Height

100% of 
Primary Logo 

Height
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Tertiary Logo 
Clear Space
Clear space is the area surrounding our brand 

stamp that must be kept free of any text or graphic 

elements. By leaving space around the logo, we 

make sure it stands out on all our communications. 

The minimum clear space is 50% of the height of 

the entire graphic element.  

 

It is sometimes necessary to increase and 

decrease the element depending on the print area. 

Always keep in proportion. Always ensure the text 

is legible. 

Download Logos

2.0 / LOGO Section 2.6: Brand Stamp Clear Space

https://drive.google.com/open?id=1Qg_eUOqZmY6bdnUBND0Of_DfoMskqfFv


Order with DoorDash
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Any changes to our logo diminish its integrity and 

the equity of our brand. The examples shown here 

are some specific “do nots” for our logo. 

The only way to use the logo(s):

1. Primary

2. Secondary

3. Tertiary

Logo Misuse

Download Logos

Do not alter the logo’s colours in anyway 

Do not lock-up text to the logo Do not alter the logo’s shape in anyway 

Do not add elements or shadows to the logo 

Do not place the logo in a holding shape 

Do not outline the logo 

Do not rotate the logo Do not change the relationship of the logo’s components 

https://drive.google.com/open?id=1pFynd_781QL8XdDbZCFSJT50lA_92pkW
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Brand 
Colours
Our brand is underpinned with a colour palette 

designed to be fresh, modern and distinctive. 

Different combinations of these colours can 

dramatically change the tone and appearance of 

our brand so it is important to consider how they 

work together. Keeping colour consistent is a vital 

element to our branding. Colour is the way we 

differentiate and identify our brand in a crowded 

marketplace. To help achieve greater brand 

recognition it is important that our colour palette 

is applied accurately and consistently. 

Print

Pantone colours are used to print the designs, 

rather than CMYK. Pantone colours will provide 

the maximum amount of consistency. In instances 

where this is not possible we have created 

optimised CMYK values. We recommend using 

real metal ‘copper’ for all menus, merchandise and 

signage applicantions of the logo.

Screens

Not all RGB colours render the same online. 

Therefore we recommend the use of hexadecimal 

colours when applying colours to screen. And 

primary usage of ‘White’ logo usage

on mobile applications such as the website.

3.0 / COLOUR PALETTE Section 3.1: Brand Colours

Pantone 
P 179-16 C

CMYK 
68 / 66 / 63 / 65

RGB 
46 / 42 / 43

HEX 
#2E2A2B

Pantone 
METALLIC COPPER

CMYK 
26 / 74 / 92 / 17

RGB 
164 / 84 / 47

HEX 
#A4542F

Pantone 
11-4800 TCX

CMYK 
9 / 6 / 8 / 0

RGB 
230 / 230 / 230

HEX 
#E6E6E6

Pantone 
P 1-1 C

CMYK 
2 / 1 / 1 / 0

RGB 
247 / 247 / 247

HEX 
#F7F7F7

Pantone 
N/A

CMYK 
0 / 0 / 0 / 0

RGB 
255 / 255 / 255

HEX 
#FFFFFF

Charcoal Copper Off
Grey

Off
White

Pure White
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RGB
R164 G84 B47

Copper is our hero colour. Keeping colour 

consistency is a vital element to our branding. 

Colour is the way we differentiate and identify 

our brand in a crowded marketplace. To help 

achieve greater brand recognition it is important 

that our colour palette is applied accurately and 

consistently.

We recommend using real metal (‘copper’) 

for signage, copper foil for menus and copper 

embroidery for merchandise.

The correct colour values are specified below. 

Make sure to use them. 

CMYK
C26 M74 Y92 K17

PANTONE®

#a4542f
Copper
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Overall Colour 
Hierarchy

    Copper
16-1325 TPX

CMYK  23 / 59 / 93 / 8
RGB  184 / 115 / 51
HEX  #b87333

    Charcoal
PMS P179-16 C
CMYK  68 / 66 / 63 / 65
RGB  46 / 42 / 43
HEX  #2E2A2B

    Off White
PMS 11-4800 TCX
CMYK  9 / 6 / 8 / 0
RGB  230 / 230 / 230
HEX  #E6E6E6

A colour hierarchy has been implemented within 

the restaurants, ranging from Copper, Charcoal 

and Off White. Copper is used for conveying 

importance. Whilst Off White is mainly used for 

background washes. 

3.0 / COLOUR PALETTE Section 3.3: Colour Hierarchy



TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 19

Web Colour 
Hierarchy

    Off White
PMS 11-4800 TCX
CMYK  9 / 6 / 8 / 0
RGB  230 / 230 / 230
HEX  #E6E6E6

    Charcoal
PMS P179-16 C
CMYK  68 / 66 / 63 / 65
RGB  46 / 42 / 43
HEX  #2E2A2B

    Copper
16-1325 TPX

CMYK  23 / 59 / 93 / 8
RGB  184 / 115 / 51
HEX  #b87333

A web colour heirarchy has been identified to 

be most trustworthy, ranging from Off White 

to Copper and Charcoal. Copper is used for 

conveying importance. Whilst Off White is mainly 

used for background washes. 

3.0 / COLOUR PALETTE Section 3.4: Web Colour



TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 20

Colour Tints

    Copper

16-1325 TPX

CMYK  23 / 59 / 93 / 8
RGB  184 / 115 / 51
HEX  #b87333

    Charcoal

PMS P179-16 C

CMYK  68 / 66 / 63 / 65

RGB  46 / 42 / 43

HEX  #2E2A2B

    Whisper White

PMS 11-4800 TCX

CMYK  9 / 6 / 8 / 0

RGB  230 / 230 / 230

HEX  #E6E6E6

100%

80%

60%

40%

20%

If there is an occasion when you need to create 

contrast without adding extra colours, you can 

use incremental tints. Our tints are to be applied 

in increments of 20%. From 80%, 60%, 40% and 

20%. Avoid using any other tints. 

3.0 / COLOUR PALETTE Section 3.5: Colour Tints



TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 21

4 Colours 100%

80%

60%

40%

20%

3.0 / COLOUR PALETTE Section 3.6: 4 Colours

     Copper

16-1325 TPX

CMYK  23 / 59 / 93 / 8
RGB  184 / 115 / 51
HEX  #b87333

     Charcoal

PMS P179-16 C

CMYK  68 / 66 / 63 / 65

RGB  46 / 42 / 43

HEX  #2E2A2B

     Whisper White

PMS 11-4800 TCX

CMYK  9 / 6 / 8 / 0

RGB  230 / 230 / 230

HEX  #E6E6E6

     Whisper White

N/A

CMYK  0 / 0 / 0 / 0

RGB  255 / 255 / 255

HEX  #FFFFFF
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ÀÁÂÃABCDEFGHIJKL
MNOPQRSTUVWXYZ
àáâãäåabcdefghijklm
nopqrstuvwxyz
1234567890
!@#$%^&*()+
ÆÇÈØ£×ßåæç Aa

Primary 
Typeface
Montserrat is our primary brand typeface. Our 

typography is as unique and elegant as we are. 

Typography is a key element in our brand. It works 

to maintain consistency, create clarity and provide 

equity to our brand. It is important to adhere 

to the typographic hierarchy specified in this 

document to help achieve brand consistency.

Download Fonts

Montserrat

4.0 / TYPOGRAPHY Section 4.1: Primary Typeface 2020 V1.0 / Page 23

https://drive.google.com/open?id=1WpzDRlB5q-SfTfS3JQQ4F3Hl2fOEDnxN
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Secondary 
Typeface ÀÁÂÃABCDEFGHIJKL

MNOPQRSTUVWXYZ
àáâãäåabcdefghijklm
nopqrstuvwxyz
1234567890
!@#$%^&*()+
ÆÇÈØ£×ßåæç Aa

Download Fonts

Lato

4.0 / TYPOGRAPHY Section 4.2: Secondary Typeface

Lato is our secondary brand typeface. Lato is a 

humanist sans-serif typeface designed by Łukasz 

Dziedzic. It was released in 2015. The name “Lato” 

is Polish for “summer”.  As of August 2018, Lato is 

used on more than 9.6 million websites, and is the 

third most served font on Google Fonts, with over 

one billion views per day. 

 

Lato compliments our minimalist typeface 

Montserrat, by adding a distinctive and classic look 

to the brand visual identity.

https://drive.google.com/open?id=1LJC0qD0C8drv6N4Ulak6NuVxyMLIbmwW
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Use of Type
One of the most important techniques for 

effectively communicating content is the use of 

typographic hierarchy. Typographic hierarchy is 

a system for organizing type that establishes an 

order of importance within the data, allowing the 

reader to easily find what they are looking for and 

navigate the content. It helps guide the reader’s 

eye to where a section begins and ends, whilst 

enabling the user to isolate certain information 

based on the consistent use of style throughout a 

body of text. It is important to maintain these type 

pairings. This allows for clarity, consistency and a 

strong hierarchy for all communications. 

 

Headings & Pull Quotes 

Montserrat Medium is to be used for all headings 

and pull quotes. 

Subheadings 

Lato Regular is to be used for subheadings.

Body Copy & Captions 

Lato Light is to be used for body copy and captions 

and when a more delicate font is required.  

 

Buttons & CTA’s 

Lato Medium is to be used for all buttons and  

call to actions. 

Lato Light is to be used for body copy. Cookie 

dessert chocolate gummi bears oat pie donut 

chocolate bar macaroon muffin. Marzipan 

jujubes danish oat cake wafer oat cake pie 

chocolate bar gummies. 

Heading Font

Subheading Font

Button Font

Lato Light is to be used for body copy. Cookie 

dessert chocolate gummi bears oat pie donut 

chocolate bar macaroon muffin. Marzipan 

jujubes danish oat cake wafer oat cake pie 

chocolate bar gummies.

Heading Font

“Montserrat Medium is to 
be used for pull quotes.”

Roboto Light is to be used for body copy. 

Cookie dessert chocolate gummi bears oat 

pie donut chocolate bar macaroon muffin. 

Marzipan jujubes danish oat danish cake wafer 

macaroon muffin oat cake pie.

Subheading Font

Heading Font

4.0 / TYPOGRAPHY Section 4.3: Use of Type
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Image Direction
All imagery should always consist of earthy golden 

based tones, with a warm and natural feel to them. 

Photographs must embody the brand through 

connection with the brand keywords.

5.0 / IMAGERY Section 5.1: Image Direction

Download Images

https://drive.google.com/open?id=1jqWgtYk_TLaMf_N3ymYrHOOdavYzaWN8
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Order Pick Up Order Pick Up

DoorDash Delivery DoorDash Delivery
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Digital 
Application

6.0 / APPLICATIONS Section 6.1: Digital Application

Already have an account? Log in Already have an account? Log in

This is an example of how our branding would be 

best applied to maintain consistency of look and 

feel on digital applications.
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Digital 
Application
This is an example of how our branding would be 

best applied to maintain consistency of look and 

feel on digital applications.

2020 V1.0 / Page 30

The Tasty
Experience

The Tasty
Experience

Already have an account? Log in Already have an account? Log in

6.0 / APPLICATIONS Section 6.1: Digital Application

Order Pick Up Order Pick Up

DoorDash Delivery DoorDash Delivery
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Digital 
Application
This is an example of how our branding would be 
best applied to maintain consistency of look and 
feel on digital applications. 

6.0 / APPLICATIONS Section 6.1: Digital Application

The Tasty
Experience

Order Pick Up

DoorDash Delivery

Already have an account? Log in



Already have an account? Log in
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This is an example of how our branding would be 

best applied to maintain consistency of look and 

feel on digital applications. 

2020 V1.0 / Page 326.0 / APPLICATIONS Section 6.1: Digital Application

Digital 
Application

The Tasty
Experience

Order Pick Up

DoorDash Delivery
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DL Envelope

Tasty Indian Bistro
8295 120 St, Delta, BC 
V4C 6R1

T +1(604) 507-9393
E info@tastybistro.com
tastybistro.com

Tasty Indian Bistro
8295 120 St, Delta, BC V4C 6R1

T +1(604) 507-9393
E info@tastybistro.com
tastybistro.com

Letterhead

Large Envelope

Business Card

Harman Basutta
Principal &
Chief Operations Officer

Stationery
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on stationery. 

6.0 / APPLICATIONS Section 6.2: Stationery

Tasty Indian Bistro
8295 120 St, Delta, BC
V4C 6R1

M  +1.778.223.1751
T   +1.604.507.9393
E   harman@tastybistro.com

tastybistro.com

Dear Michelle Owns,

My name is Jean Stephens. I was sent here to be the first brand engagement 
for Tasty Indian Bistro. Over the past 11 years, I have worked with the Tasty 
sweets brand develop into something special. My mission is to serve the 
brand, and support the founders.

Epudit volorepelest labo. Itat.
Nemporum quidenet rendebis dolupicium ne debitius et landus, nes aut 
estinvenecto blabor molorro corepudit quis rectus que net vel maio core 
re veribus nonserrum simoluptas aruptam, cus excea ea pa comnimusanto 
corem fugia ped qui occus excerfe rchicil magnis incimpe arum non estius.
Parum, omnitatet fuga. Ed et ut laborion eumquis tiberem poriassumque 
nimil ipsus, cum quatata tibusciis voleniet, quo iur, alit occaborepro eum 
dem fugit eati idestemqui ditam es essi con comniasit ut as nonsed quis 
dolenim cum aut arciet, cuptur aliquuntia soloreseque modic tes cusci 
apicimus.
Les as alit as sant resto volo dolecuptat imod qui dolupti buscid est in pa 
int, ommolo que conseque verum ium ipsus rem. Et a que omniet a quodisc 
ipsam, quis cus.

Ra debis sit, occum imaio cus, si offic toriati culluptatur?
Ut etur, occae cone nobis ut ratium qui ut re veliciiscias vendae volorem. Us 
andi blautam at laut aut autatur?

Itaeris eum, solenis etur? Quiatem qui quid molor mini dem nit asintoratur, 
sequi aut adis velibus nullat maioreprem. Orisit, sitatist, od maximo ium 
volestrum vendio. Itasitat.
Ehenden ihilles aut andel il ipideliaes explatibus undelec eroriat alibusda 
vollend estrum res modit a quaeri repudaest, offictate volorum hil iducid 
militat alitas as natibus imillendae verum repro etus sin elique corporp 
quia a earum quas alit fuga. Et lam rehenda ecuptat ionsequ aestrum que 
voloreptia quiat antia dolupta sit autem ulparuptaque receaquam, tecea ne 
nis aceatur aut occulparibus vendant et odite corumque quae et unt alit et 
pariatia prae nihiliquid quati ipient.

Regards,
Jean Stephens
Engagement Manager
+1604.505.7223
j.stephens@tastybistro.com

Attn:  Michelle Owns
Re: Your Recent Google Review
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Leather &
Metallic Ink
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on stationery. 

6.0 / APPLICATIONS Section 6.2: Stationery
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24pt Black Paper
& Metallic Ink

This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on stationery. 

6.0 / APPLICATIONS Section 6.2: Stationery



TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

2020 V1.0 / Page 36

Bottles
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on Tasty bottled beverages.

6.0 / APPLICATIONS Section 6.2: Stationery
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Gift Wrap
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on gift wrapping..

6.0 / APPLICATIONS Section 6.2: Stationery
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Staff Polo
Shirt
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on staff clothing.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Black 
Clothing
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on clothing.

6.0 / APPLICATIONS Section 6.3: Merchandise
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White
Clothing
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on clothing.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Head Chef 
Apron
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on staff clothing.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Business Cards
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on business cards.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Gift Set
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on the gift set.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Coffee Cups
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on take away packaging.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Specials Menu
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on the specials menu.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Coffee Cups
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on Tasty bottled beverages.

6.0 / APPLICATIONS Section 6.2: Stationery
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Merchandise
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on merchandise. 

6.0 / APPLICATIONS Section 6.3: Merchandise
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Take Away
Packaging
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on take away packaging.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Canned
Beverage
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on canned beverages.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Water
Bottle
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on water bottles.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Print
Renderings
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on print.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Vehicle
Graphics
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on vehicles.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Sanitary Mask
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on medical supplies.

6.0 / APPLICATIONS Section 6.3: Merchandise
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Storefront
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on storefront signage.

7.0 / APPLICATIONS Section 7.1: Storefront
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Delta
Flagship
Location
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on storefront signage.

7.0 / APPLICATIONS Section 7.1: Storefront
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Yaletown
Location
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on storefront signage.

7.0 / APPLICATIONS Section 7.1: Storefront
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Menu
Cover
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on menus.

8.0 / APPLICATIONS Section 8.1: Menu System
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Menu
Inside

8.0 / APPLICATIONS Section 8.1: Menu System

This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on menus.
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The Secret
Menu

8.0 / APPLICATIONS Section 8.1: Menu System

This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel of the secret menu.
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Employee
Manual
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on employee manuals.

The employee manuals, notepads and mail 

packages are critical brand assets for onboarding 

all new staff. Each new staff member, should 

be issued the entirety of the employee manual 

package, sealed and secured within the classic 

Tasty Indian Bistro copper blister packaging.

9.0 / APPLICATIONS Section 9.1: Employee Manual
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Extra Special 
Correspondance
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on blueprints and architecture documents.

Extra special documents, are to be accompanied 

by the Tasty Brand monogram. Please refer to 

the Tasty Brand - Brand Guidelines Document 

for more information on rules, specifications and 

application instructions.a

9.0 / APPLICATIONS Section 9.2: Extra Special Correspondance
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Extra Special
Letters and
the Official
TB Seal
This is an example of how our branding would be 

best applied to maintain consistency of look and  

feel on blueprints and architecture documents.

Extra special documents, are to be accompanied 

by the Tasty Brand monogram. Please refer to 

the Tasty Brand - Brand Guidelines Document 

for more information on rules, specifications and 

application instructions.a

9.0 / APPLICATIONS Section 9.3: Extra Special Letters
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Placeholder Text

Please note all copy in this document is for placeholder purposes 

only. Please customise to suit your own brand as it continues to 

evolve. 

 

Fonts

If you haven’t already done so, please go ahead and download and 

install the fonts included in the text file. We have used Montserrat & 

Lato for this document which can be downloaded from Google fonts. 

Colours 

You can quick and easily change to your brand colours by using the 

Swatches Palette. Replace our colours with yours by double-clicking 

on the individual swatch and changing the colour values.  Please note 

that some of the colours used are RGB colours, which is great for 

screen. If you are going to print you will need to change to CMYK. 

Master Pages

What is a Master Page? Master Pages are non-printable pages that 

act like a template to create a consistent look for your document. 

There are 4 master pages in this document: A-Master, B-Master, 

C-Master & D-Master. 

 

To edit: 

Window > Pages

Double-click on the master page and make your edits here. For more 

into see page 4 of the  Help Guide. 

Guides

To turn off/on the guides. Go to: 

View > Grids & Guides > Show /Hide Guides 

Helpful Tips or use the shortcut Cmd ; to toggle between the two modes.

To view without columns and guides: 

View > Screen Mode > Preview

To view column and guides: 

View > Screen Mode > Normal

or use the shortcut W to toggle between the two modes. 

 

Baseline Grid

To turn off/on the baseline grid. Go to: 

View > Grids & Guides > Hide Baseline Grid.  

Some text will be aligned to the baseline grid. 

Paragraph Styles

A reference guide to the Paragraph Styles used in this document 

have been included over the page so you can easily navigate your 

way through the Paragraph and Character Styles in this document. 

To open the Paragraph Styles palette: 

Window > Styles > Paragraph Styles 

 

To open the Character Styles palette: 

Window > Styles > Character Styles

To change the fonts: 

Open up a Style (i.e. Heading 1) > Basic Character Formats > Font 

Family

Help Guide

We’ve also included our standard Help File to help you out. Please 

read through this guide first as many of your questions have already 

been covered in our guide. 

Helpful Tips How to Use our Brand Guidelines Document



TASTY INDIAN BISTRO Brand Guidelines www.tastyindianbistro.com

+1 (604) 507-9393
info@tastybistro.com

8295 120 Street, Delta, BC
CANADA  V4C 6R1

10.0 / CONTACT info@tastybistro.com 2020 V1.0 / Page 67



Brand  
Guidelines

The Tasty Experience

Brand Guidelines 2020

TASTY INDIAN BISTRO tastyindianbistro.com


